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2 Introduction 

2.1 About this booklet 

On the following pages, we would like to present to you the feature highlights 
of version 8.8 of GAMMA Dental Software (GDSW). This update includes 
many improvements and new features for the CADIAX®, CADIAS®, and CA-
DIAS® 3D analysis modules as well as for the patient management in 
GAMMA Document Browser and GDSW classic. 

Several of the changes implemented in this software version have been sug-
gested by our user basis worldwide. If you also have ideas or suggestions for 
possible improvements, please do not hesitate to contact us. 

2.2 Downloading the software 

The most recent version of GAMMA Dental Software is available for down-
load from the Downloads section of our website at www.gammadental.com. 
There, you can also find the current Instructions for Use for all our products 
and additional information material for free and without registration. 

 

You can also request a paper copy of the Instructions for Use by 
contacting us directly. Shipping within the European Union is free 
of charge. 

 

After having downloaded the installation package as a setup file, simply exe-
cute that file to start the installation. 

2.3 Installation from the flash drive 

GAMMA Dental Software is also 
available on a USB flash drive that 
contains not just the software in-
stallation package, but also the In-
structions for Use in PDF format. 
The flash drive is write-protected 
and will appear as an additional 
drive named “GDSW” in your file 
explorer when plugged in. Figure 1: Installation from flash drive. 

https://www.gammadental.com/
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To start the installation, simply insert the USB flash drive into a free USB port 
of your computer. The logo printed on the flash drive should typically be lo-
cated on the top side. If the installation routine does not start automatically, 
you can launch it by executing the file setup.exe that you can find in the folder 
Setup on the GDSW drive. The Instructions for Use are located in the sub-
folder Manuals. A suitable PDF viewer application is included with every Win-
dows installation. 

2.4 Installation procedure 

If an older version of GAMMA Dental Software already exists on your com-
puter, the installation routine will perform an update, which will preserve your 
personal configuration settings. The update procedure will in no way touch 
your pre-existing patient files. Nevertheless, we recommend backing up 
your patient data before installing the update. You can easily identify the 
patient files to back up by their file extensions *.gdb for GAMMA Document 
Browser and *.fgw for GDSW classic. The database directory where these 
files are located is indicated in the respective application. 

Do not switch off your computer during the installation. If you are installing 
the software on a laptop computer, please ensure that it will not run out of 
power during the installation procedure. 

Furthermore, please ensure that you have your license code at hand when 
launching the installation routine. You can find this code on your license letter 
that you received as part of the installation package. Contact us if you need 
a copy of the license letter at a later time.  
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In the very first steps of the installation procedure, you are asked to choose 
the language to be used for the software and to accept the license agree-
ment. 

Afterwards, please enter your license code and optionally your user infor-
mation (Figure 2). The latter is used for identifying the workstation and your 
practice or company on the printouts created by the software. Click Next to 
continue. 

 
Figure 2: Enter your user information and the license code. 

In the subsequent step, you can change the directory to which the software 
will be installed. We recommend to proceed with the predefined settings. 
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Afterwards, you will be asked to specify the directory in which you want to 
store your patient data (Figure 3). If you need to access the data from multiple 
PCs, you can specify a network drive that is accessible to all of them. 

 
Figure 3: Select the directory in which your patient data should be stored. 

The next window summarizes the installation settings. To change any of 
them, go back to the respective step by clicking on Back. 
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2.5 Software activation 

After the successful installation of GAMMA Dental Software, you can choose 
to start either GAMMA Document Browser or GDSW classic. In either case, 
you will be asked to activate the software (Figure 4). 

 
Figure 4: Activation is always performed for the complete GDSW package, regard-
less of which application invoked it. 

The activation procedure has to be carried out only when you start the soft-
ware for the very first time. Depending on the license code entered during 
installation, different software modules will be made available. To check your 
license information or enter a new license code after activation, use the menu 
Help > About in the software. 

Warning: 

Using GAMMA Dental Software in a virtual environment (e.g., Parallels® 
Desktop) may cause poor performance or even loss of certain functionalities. 

If you plan to use the software in a virtual environment anyway, we strongly 
recommend updating both your operating system and your virtualization soft-
ware to the latest version before activating. Subsequent updates of these 
components can cause a change of the system information that is registered 
by GAMMA Dental Software, which will render your activation invalid. 
GAMMA does not take any responsibility for validity of license codes being 
lost this way. For these reasons, please use a native Windows environment 
instead (e.g., Boot Camp on Apple macOS computers, if available). 
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For activating GAMMA Dental Software on a computer with internet connec-
tion, simply select Online activation in the following dialog (Figure 5) and click 
on Activate. No further steps are required in this case and you can immedi-
ately start using the software. 

 
Figure 5: An active internet connection is convenient, but however not necessary 
when activating GAMMA Dental Software. 

If you are installing GAMMA Dental Software on a computer without an active 
internet connection, please select Offline activation. Send the displayed acti-
vation code to GAMMA either via e-mail or by fax or visit the GAMMA activa-
tion website (Figure 6) on another device to activate your software: 

activation.gammadental.com 

https://activation.gammadental.com/
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Enter your customer number and 
the activation code shown in the 
software and click on Activate. 
The system provides Export and 
Import functionalities on both 
ends to minimize the risk of typo-
graphic mistakes. 

The website will return a confir-
mation code, which you will have 
to enter in the corresponding in-
put box of the activation dialog 
(Figure 5). By clicking on Acti-
vate, software activation is now 
also completed on a system with-
out internet connection. 

GAMMA Dental Software is now 
ready for use. In case of any 
questions regarding the installa-
tion or usage of the software, please do not hesitate to contact us via: 

E-Mail: support@gammadental.com 

Phone: +43 2243 34140 

Fax: +43 2243 34140 90 

Our hotline is at your disposal on workdays from Monday to Friday between 
9 AM and 4 PM (local time Vienna). 

Figure 6: Offline activation enables you to 
activate the software on computers without 
an internet connection. 

mailto:support@gammadental.com
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3 Updates in version 8.8 

3.1 CADIAS® 3D 

Undoubtedly, computerized digital methods are an ongoing important factor 
in modern dentistry. Typical dental developments in the industry aim directly 
at the design and manufacturing of prosthetic appliances in the dental labor-
atory, wherefore digital dentistry nowadays is more a topic for the dental lab 
than it is for the practitioner’s office. The aspects of functional analysis are 
widely ignored or neglected by those developments. 

The field of instrumental functional analysis is one of the key points of the 
Vienna School of Interdisciplinary Dentistry (VieSID) in the systematic ap-
proach to establish valid and patient-specific evaluations. In particular, occlu-
sal analysis of articulated models is of prime importance. With CADIAS® 3D, 
GAMMA has developed a sophisticated 3D software system that aims to fill 
the gap in digital dentistry to allow occlusal model analysis as part of the 
computerized workflow. 

 

For a complete overview of the features provided by CADIAS® 3D, please 
refer to the Instructions for Use of GAMMA Dental Software, which you can 
also access via the Help menu in the software. The software comes with a 
fully documented patient case, named “Test Patient 3”, which you can use to 
get acquainted and experiment with CADIAS® 3D. Go ahead and give it a try! 
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3.1.1 Creating 3D-printed models with Reference Print&Click 

A fully digital workflow usually entails the absence of physical models, which 
complicates crucial steps such as the final functional verification of digitally 
designed restorations. The Reference Print&Click Set (order no. 06-230960) 
solves this problem by facilitating the accurate articulator mounting of 3D-
printed dental models. 

 

 

 

Figure 7: Order no. 06-230960 –  
Reference Print&Click Set 

 

 1  Articulate Intraoral Scans 

Intraoral scans are transferred to the virtual articulator using GAMMA’s 
unique digital workflow. This ensures a correct relationship between the 
digital models and the exact kinematic TMJ hinge axis. 
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The articulated intraoral scans are converted to printable models using a 
Model Creator application such as by exocad, 3Shape, or Medit. 

 2  Create Printable Models 

In CADIAS® 3D, the printable models are connected to a base plate that 
clicks onto a suitable Print&Click mounting block, preserving the hinge-
axis relation of the digital models. 

 3  Connect to Base Plate 

 4  Send to 3D-Printer 

The final Print&Click models can be sent directly to any 
3D-printer. No additional consumable parts required. 
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The creation of 3D-printable models for the Reference Print&Click mounting 
system is integrated as a step-by-step workflow on a new 3D Model Printing 
pane in CADIAS® 3D. After importing and selecting the models from your 
selected Model Creator application, the next step is to open the bottom plane 
of the models. This allows the attachment of a Print&Click-compatible mount-
ing plate while keeping the articulated position of the models unchanged. The 
optimal height of the mounting blocks is selected automatically to minimize 
the volume for 3D-printing. The resulting extended models can subsequently 
be exported to your 3D-printer in STL or another open file format. 

  

Figure 8: A simple step-by-step workflow in CADIAS® 3D guides you through the 
creation of Print&Click models (right) from the printable base models (left). 

The workflow also allows customizing the created models by applying user-
defined text labels, such as for patient name, creation date, laboratory name, 
etc. The font style of these text labels, but also the geometry of the base plate 
can be adapted based on your preferences and 3D-printing requirements. 

The use of 3D-printed models ensures high reproducibility of a given model 
situation at any time in the future, without the need for storage space or con-
trolled storage conditions, as is the case with physical models. By relying on 
third-party Model Creation software for creating the printable models, even 
advanced features such as introducing removable tooth dies, adding support 
pins for securing the maxillomandibular relationship, and optimized infill pat-
terns for hollow models can be included. Finally, the Reference Print&Click 
mounting system does not require any consumable parts besides the actual 
3D-printing material. 

However, please be aware that the quality of 3D-printed models is highly de-
pendent on the 3D-printing process. It is therefore essential to calibrate and 
validate your workflow before putting the system into practice. 
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3.1.2 Visualization of occlusal distances in real-time 

CADIAS® 3D already provides an ex-
tensive set of tools for analyzing 
static and dynamic occlusion in the 
form of static and dynamic occlusal 
protocols. To allow for analysis with 
an even finer degree of control, it is 
now possible to visualize the dis-
tances between maxillary and man-
dibular teeth in real-time. The feature 
can be easily activated by pressing 

Show distances in the toolbar. 

When replaying a lower jaw move-
ment, a color gradient will indicate the 
distances to the respective antago-
nist directly on the occlusal surfaces. 
Guiding or interfering tooth contacts, 
but also areas of close proximity can 
thus be detected easily throughout 
the entire movement. This visualiza-
tion can be used for real lower jaw 
movements recorded with CADIAX® 
devices or articulator-guided move-
ments, and can also be combined 
with the existing static and dynamic 
occlusal protocols. It may also be 
used while repositioning jaw models 
or individual teeth during VTO to show 
the effects in real-time. 

Lastly, the distance visualizations can be turned on or off for upper and lower 
jaw models independently and can also be adjusted with respect to the dis-
tance range of intersections and clearances to be visualized. 

3.1.3 Model repositioning to CPM position 

When creating a VTO (Visualized Treatment Objective) in CA-
DIAS® 3D, it is now also possible to reposition the upper and/or 
lower jaw model to a selected CPM position (Condylar Position 
Measurement) such as from RP to ICP or vice versa. 

Figure 9: Occlusal distances between 
upper and lower jaws can now be vis-
ualized in real-time. 

Figure 10: The visualized distances im-
mediately reflect any occlusal adjust-
ments made during VTO mode. 
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3.1.4 Close models to first contact 

When mounting plaster models in the articulator, it is often desired to mount 
them in condylar reference position (RP), closed to first tooth contact. This 
retral contact position (RCP) is sometimes difficult to achieve with an incisal 
pin height of zero, due to the variable thickness of the centric registrate. 

To skip this step with lab scans of analog models and instead provide a digital 
method of achieving first tooth contact easily and reliably, CADIAS® 3D now 
provides a new VTO operation that closes either the upper or the lower jaw 
model to the first tooth contact. This functionality can also be used after the 
model situation has been modified, such as after a mandibular repositioning. 

 

Figure 11: CADIAS® 3D now allows closing jaw models to the first tooth contact. 

3.1.5 Setting custom color for 3D objects 

3D objects displayed in CADIAS® 3D 
are by default displayed in schematic 
colors that make it easy to discern in-
dividual objects. Some types of data, 
such as intraoral scans, may even in-
clude true color information that has 
been captured during 3D scanning, 
which can be useful to create a more 
realistic visualization. 

To provide an additional option for il-
lustrative purposes, it is now possible 
to assign custom colors for each dis-
played 3D object individually. 

Figure 12: Any 3D object displayed in 
CADIAS® 3D can now be assigned a 
custom color to improve visual impact. 
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3.1.6 Improved management of additional 3D objects 

Besides jaw models, CADIAS® 3D 
also allows importing arbitrary 
additional 3D objects into the scene. 
These additional objects may be 
used for visualization or may also 
serve a functional purpose, such as 
the bite fork scan used for articulating 
intraoral scans as part of the digital 
workflow. To improve the handling of 
these additional objects, CADIAS® 
3D now provides a dedicated list in 
the Objects tool window. This list 
allows controlling object visibility, as 
well as renaming, removing, or 
exporting individual objects. 

3.1.7 Miscellaneous improvements 

– It is now possible to edit 3D meshes during the digital workflow in 
the 3D Data Assistant, which can be useful to correct scanning ar-
tifacts in the bite fork scan. 

– When modifying condylography curves in CADIAX®, such as per-
forming a zero-point adjustment or hinge axis correction, the 
changes will now immediately be reflected in CADIAS® 3D. 

– When exporting lower jaw movements for the exocad® Jaw Motion 
Import module, the Jaw Motion files will now include additional data 
to skip having to select a curve’s starting position during the import. 

– The application now also supports the standard keyboard shortcut 
Ctrl + Shift + C to copy the currently displayed view as an image 
into the clipboard. 

3.1.8 Fixed issues 

– The gradient coloration of the distance map in the static occlusal 
protocol did not transition smoothly between adjacent colors. 

– When exporting the already aligned bite fork scan during the digital 
workflow in the 3D Data Assistant, the exported data did not con-
sider this alignment. 

Figure 13: Additional objects in the 3D 
scene can now be managed conven-
iently within CADIAS® 3D. 
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– A visual glitch that occurred when deactivating VTO mode with 
guidance paths of the dynamic occlusal protocol being displayed 
has been resolved. 

– Activating a predefined view in CADIAS® 3D under some circum-
stances caused additional objects to become visible. 

– An unhandled exception caused by changing the model selection 
during a movement replay has been fixed. 

– Several issues related to unexpected data formats when importing 
3D objects from PLY and STL files have been fixed. 

3.2 CADIAX® 

3.2.1 CADIAS® 3D jaw models in 3D Animation 

The 3D Animation in the CADIAX® analysis and recording applications visu-
alizes mandibular kinematics with the purpose of improving understanding 
and communication. It hitherto used a simple generic 3D model of the skull 
and mandible, which has now been improved to also allow selecting the jaw 
models imported in CADIAS® 3D. This enables a live visualization or replay 
of lower jaw movements using the model scans or intraoral scans that have 
been articulated in GAMMA’s virtual articulator. Combined with the real-time 
visualization of occlusal distances, this allows for a comprehensive occlusal 
analysis either chairside or after the examination. 

  

Figure 14: Any jaw models loaded in CADIAS® 3D can now also be used for visu-
alizing the lower jaw movements in the 3D Animation of CADIAX® – during the 
analysis, but also during the recording. The real-time display of occlusal contacts 
introduced in CADIAS® 3D is also available here. 
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3.2.2 Magnified coordinate system view 

When taking condylar position meas-
urements (CPMs) in CADIAX®, for 
some patients, the measured condy-
lar positions may be very close to 
each other. This could make it diffi-
cult to differentiate the individual 
point measurements. 

To improve the readability of these 
measurements, it is now possible in 
all CADIAX® applications to turn on a 
magnified view of the coordinate sys-
tem using a dedicated toolbar button 

 Magnify Coordinate System. This 

option can be activated at any time 
and will shorten the coordinate system axes for an enlarged measurement 
display. As positions near zero may also land in the posterior quadrants of 
the coordinate system, the negative X and Z axes are also provided. 

The coordinate system magnification can also be used during CADIAX® re-
cording, for instance to ensure that the red cross of the real-time cursor is 
located near reference position before starting the measurement. 

3.2.3 Miscellaneous improvements 

– The export of CADIAX® lower jaw movements as Jaw Motion files 
for the exocad® CAD/CAM application is now more accessible with 
a dedicated menu item in the File > Import / Export menu. 

– The user interface for specifying tooth kinetics positions in the 3D 
Animation has been revised, and the 3D Animation now also re-
spects the field of view setting that was specified in CADIAS® 3D. 

3.2.4 Fixed issues 

– The recovery files of CADIAX® recordings were not saved correctly 
if the patient name contained an unusual punctuation character 
such as a slash or a colon. 

– Some missing localizations for various languages in the 3D Anima-
tion have been added. 

Figure 15: CADIAX® now provides an 
optional magnified view of the coordi-
nate system, such as for CPMs. 
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3.3 CADIAS® 

3.3.1 Analysis according to European Board of Orthodontics (EBO) 

The European Orthodontic Society (EOS; eoseurope.org) is a not-for-profit 
association founded in 1907 with the aim to advance orthodontic research, 
techniques, and clinical practices. In affiliation with the European Board of 
Orthodontics (EBO), they conduct a prestigious certification exam designed 
to recognize clinical excellence in orthodontics within Europe. 

To simplify the documentation of cephalometric tracings and numerical anal-
yses conforming to the requirements of the EBO exam, CADIAS® now inte-
grates the respective definitions out-of-the-box. 

  

Figure 16: CADIAS® now provides the definitions of a tracing and numerical anal-
ysis specifically for the European Board of Orthodontics (EBO) certification exam. 

3.4 GAMMA Document Browser 

3.4.1 Improved scroll behavior in Workspace view 

The Workspace view of GAMMA Document Browser provides a structured 
and consistent view of the patient data that can be fully customized in its 
content and appearance. This includes basic changes to color and font styles, 
but also the adding or removing of entire sections or individual cells. To sim-
plify these customizations, the application will now always try to avoid chang-
ing the scroll position when items are inserted or deleted. 

https://eoseurope.org/
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3.4.2 Improved CADIAX® and CADIAS® previews 

CADIAX® and CADIAS® previews in 
GAMMA Document Browser can be 
configured to automatically show a 
specific representation of the under-
lying data, such as tracings or nu-
merical analyses for CADIAS®, or 
axis movements or time curves for 
CADIAX®. However, by opening an 
analysis and saving in a particular 
view, that view was hitherto saved as 
a “manual” preview, overriding the 
automatically generated one. 

This behavior has been made more 
intuitive so that by default, no manual 
previews will be generated, and the Workspace will thus preserve the data 
representation configured in the schema design template. You can configure 
this setting via the menu Extras > Options, in the Display category. 

Additional improvements include additional properties for the CADIAX® pre-
views, which now support overlay mode also for time curves, axis move-
ments, and translation-rotation graphs. It is now also possible to only show 
curves that have been selected for articulator calculation. 

3.4.3 Cell Design improvements 

The Cell Design view in GAMMA 
Document Browser allows an even 
finer degree of customization for how 
data is displayed in the individual 
cells of the Workspace. For a more 
precise alignment of cell design ele-
ments, such as text boxes, shapes, or 
data areas, the view now provides a 
customizable point grid in the back-
ground. Elements can be moved in 
small increments using the arrow 
keys. Lastly, it is also possible to in-
sert new cell design elements with a 
single click of the left mouse button. 

Figure 17: Manual analysis previews 
offer flexibility, but may cause an in-
consistent Workspace appearance. 

Figure 18: The Cell Design view now 
provides a customizable background 
grid and easier element positioning. 



GAMMA Dental Software 

22 

3.4.4 Entering office/user information 

When installing GAMMA Dental Software, 
the software allows entering the name of 
the office and user, which will be printed 
on the printouts and used for features 
such as the labelling of 3D-printed models 
in CADIAS® 3D. Changing this infor-
mation was hitherto only possible in 
GDSW classic, but is now also possible 
via the menu Extras > Enter Office/User 
Data in GAMMA Document Browser. As 
this information will be used across all 
user accounts, changing it requires the 
application to be run as an administrator. 

3.4.5 Export of text documents 

Text documents in GAMMA Docu-
ment Browser are a convenient way 
to document written patient findings 
such as a diagnosis or a treatment 
plan. These text documents can now 
be exported from the Raw Data view 
as RTF files (Rich Text Format) to al-
low editing in other applications. 

Please note that the creation and ed-
iting of text documents requires the 
presence of the WordPad applica-
tion, which has been deprecated with 
Windows 11 version 24H2. While it is 
possible to restore the application from an older Windows installation, we rec-
ommend using Foreign OLE Objects instead, which allow embedding any 
type of file in a data area in the Workspace. To do so, set the “Data item type” 
of a data area to “Foreign OLE Object” via the Properties panel. 

3.4.6 Miscellaneous improvements 

– It is now possible to select multiple CADIAS® data areas in the 
Workspace in order to configure their properties simultaneously. 

Figure 19: The user and office 
name for a GDSW installation can 
now also be changed in GAMMA 
Document Browser. 

Figure 20: Foreign OLE Objects may 
be used to embed any type of file 
(shown is a PowerPoint presentation). 
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3.4.7 Fixed issues 

– An issue resulting in inconsistent data area properties when 
switching between “Automatic” and “Manual” preview types has 
been resolved. 

– User-defined image types imported from an opened patient file 
were inadvertently discarded when closing the Options dialog. 

– A rare application crash that occurred when closing a patient file 
while the Properties panel was opened has been fixed. 

– An unhandled exception when attempting to directly link a specific 
data item to a data area has been fixed. 

– The conversion of GDSW classic data to the file format of GAMMA 
Document Browser indicated a successful conversion even if some 
files could not be converted due to data corruption. 

3.5 General 

3.5.1 Miscellaneous improvements 

– When closing GDSW classic while having a patient filter activated, 
the application would persist that setting across application re-
starts, which could give the impression that patient data has been 
lost. This has been changed so that the filter settings are cleared 
automatically when the application is closed. 

– Missing localizations of the user interface have been updated in 
various locations. 

– The software activation website (activation.gammadental.com) 
that allows activating the software on a computer without internet 
connection now uses HTTPS throughout to improve security.

https://activation.gammadental.com/
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